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General

Th eory 1 of the Universe
Th eory 1: Th ere is a theory which states Th eory 1: Th ere is a theory which states Th eory 1:

that if anyone ever discovers exactly what 
the Universe is for and why it is here, it 
will instantly disappear and be replaced 
by something even more bizarre and 
inexplicable.

Th eory 2: Th ere is another theory which 
states that this has already happened.

Betsy Mill, SDMUG Member

Mac Puzzles
Nicholas Pyers, an avid Macintosh user, 

generates a Macintosh focused puzzle or 
crossword each month for the enjoyment 
(or frustration) of Macintosh fans.    ;)

Some months the puzzles are a typical 
Crossword, other months the puzzles are a 
Word Search where you either look for the 
hidden words listed, or the hidden words 
must be guessed from clues provided. Th e 
puzzles are released approximately mid-
month and can be found on Nicholas’ 
website at: 
http://www.nicholaspyers.com/puzzles/.

Nicholas Pyers

Mac Design — 
One of the Best Magazines I Have Read

Mac Design is a magazine that can be 
very useful if you use Adobe’s Photoshop, 
Illustrator, GoLive, or AfterEff ects; 
Macromedia’s Flash or Dreamweaver; or 
QuarkXPress, Painter, Director, and others. 
Th e really nice thing about this magazine 

is that it actually teaches you how to use 
these programs more eff ectively.

Each issue includes a set problem and 
the solutions for that problem in many of 
these programs. Step-by-step instructions 
always accompany the fi nely detailed 
screen shots and photos that enrich the 
articles. Mac Design is online and you can 
see tutorials on all of the programs listed. 
Check it out for yourself at: 
www.macdesignonline.com.

NotePad, Springfi eld IL

Opening Customize 
Toolbar Window

Here’s a great secret shortcut for opening 
the Customize Toolbar window: Shift/click 
the “Old Finder Mode” button (the white 
capsule in the upper-right corner of every 
Finder window.

David Pogue’s 
Mac OS X: Th e Missing Manual

Eject a CD from Flat Panel iMac 
Using Open Firmware

To eject a disc with Open Firmware 
commands, follow these steps:
 1.  Restart the computer.
 2.  Immediately after the startup 

sound, press and press Command/
Option/O/F. Note: Th e Command 
key has the Apple icon on it.

 3.  Release the keys when you see a 
white screen that says, “Welcome to 
Open Firmware.”

 4.  At the prompt, type “eject CD.”
 5.  Press “Return” and wait a few seconds. 

Welcome!
You may have already 

noticed that our website has 
been redesigned. At the bottom 
of my home page is a link to 
Gradware.com, an academic 
software distributor. If you 
are a student or a teacher, you 
can save up to 80% on your 
software. Any purchases you 
make through my link will help 
support the Mac Hints & Tips 
newsletter. Follow the link and 
check out their prices. 

Deborah Shadovitz, board 
member of the late Los Angeles 
Mac Group, author of the 
GoLive Bible, and source of 
many tips quoted here in Mac 
Hints & Tips, is producing 
her Second Annual Regional 
Macintosh Gathering in North 
Hollywood, California, from 
Friday May 13, thru Sunday 
May 15. Featured are a special 
free seminar on using Virtual 
PC 7 and Entourage on Friday 
from 2–5 pm, a FileMaker Pro 
Bootcamp, exhibits by software 
and hardware companies, plus 
several seminars being held all 
week-end long. 

To learn more, please visit 
www.macgathering.com. 
I hope to see you all there.

— Paul Taylor
paul@mac-hints-tips.com

http://www.nicholaspyers.com/puzzles/
http://www.macdesignonline.com
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Th e disc drive should eject any 
disc that is present, and “OK” 
appears behind your command 
when the action is complete.

 6.  Type “mac-boot”
 7.  Press “Return.” Your computer 

should now startup normally.
Other methods include trying 

to reboot while holding down the 
Eject key, and if that doesn’t work, 
try holding down the mouse button 
while starting up.
Apple Pickers MUG, Indianapolis, IN

Not Your Virus
Sooner or later you will join the 

huge number of computer users who 
have received messages from various 
email systems informing them that a 
message they sent contained a virus. 
What’s important to understand 
here is that you probably do not 
have a virus and did not send one 
in an email. (Well, let’s say that the 
likelihood is remote.) 

In fact, if you examine the 
“guilty” email, you’ll fi nd that you’ve 
never even heard of the addressee.

What’s happening involves 
not your Mac at all, but rather a 
Windows PC belonging to a friend 
or colleague, and it’s this person 
who has acquired a virus. 

Th is kind of PC virus sets about 
sending email messages with copies 
of itself to everyone in your friend’s 
email address book. At the same 
time, it alters the sender’s address 
on those messages, to an address 
selected again from your friend’s 
address book. In this case, it has 
selected yours!

Th is means that all the virus-
carrying messages give your address 
as the sender’s, and this is why 
you’ve received messages telling 
you that you’ve been distributing 
a virus! Th e reality is that you’re 
guilty only of appearing in your 

friend’s address book.
While there are other kinds of 

viruses that work in diff erent ways, 
this kind has been by far the most 
common in recent months. Th e 
principle clue is the fact that the 
message recipient(s) nominated in 
the alert message are completely 
unknown to you.

Mac users in general can be 
reassured that viruses aff ecting their 
machines remain as rare as ever (and 
for OS X users, that means there has 
not been one detected to date).

Having said that, it’s theoretically 
possible for you to unknowingly 
forward a PC-virus-bearing message 
(received from someone else) to 
a PC user who will suff er from 
it. Virus checker programs can 
sometimes detect viruses present 
in such messages, but often cannot. 
Moral: don’t forward messages that 
have attachments to PC users, and 
if you must forward a particular 
message, retype or cut-and-paste the 
text into a new message fi rst.
AUSOM News, Melbourne Australia

Label Replacement
You can’t have labels in OS 

X, but you can use Comments 
in a list view window instead. 
Click once on an item. Use “Get 
Info” (Command/I). Click the 
Comments arrow.

Type something into the 
Comments text fi eld. Close Get 
Info. With the item highlighted 
(selected), pull down the View 
menu to Show View Options 
(Command/J). Place a checkmark 
beside Comments. Close the 
Options window. You now have 
your comment about the item 
visible in the list view window. If 
you select the Comments column, 
you can sort on it if you like.

Mouse Droppings, Corvallis OR

Video Smideo
Ron Touchstone, who is one of 

our members, recently inquired 
about how to get VHS tapes to 
digital video. After a little research, 
I came up with these options:

1. CANOPUS ADVC-100 
($269)
Th e CANOPUS DVC-100 

features Canopus’ award-winning 
DV codec technology, which 
is found in AVID’s Xpress DV 
software and the full line of 
Canopus DV capture cards. Locked 
Audio Support Other converters 
can lose audio/video sync when 
converting longer segments of 
video. Th e ADVC-100 is the 
fi rst inexpensive DV converter 
that supports locked audio when 
converting from analog to digital, 
assuring perfect audio and video 
synchronization

2. Dazzle DM2200 Hollywood 
DV-Bridge PC/MAC ($218)
With Hollywood DV-Bridge, you 

can convert your old VHS tapes 
to high quality DV video. Th e 
video world is moving from analog 
to DV and converting your video 
to DV ensures it will be around 
for the future in a standardized 
high quality format. You can 
also convert your DV video to 
analog. Th is makes it easy to send 
videotapes to people with analog 
VCRs. You can even take clips 
from your analog and DV tapes 
and combine them into one master 
production. With Hollywood 
DV-Bridge, you edit your video 
in the DV format that means you 
won’t lose any video quality in the 
editing process. Hollywood DV-
Bridge is the universal solution for 
converting and editing analog and 
DV video. Hollywood DV-Bridge 
supports any Windows-based PC 
or Macintosh computer with a 
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FireWire/i.LINK/1394 interface, 
off ering unprecedented Analog/DV 
video input and output fl exibility. 
Th e versatile converter can be used 
with an analog or DV camcorder, 
with Apple’s iMovie and Final Cut 
Pro software or other leading DV 
video editing solutions. Equipped 
with analog and DV inputs, it 
enables users to capture video from 
analog sources such as a VCR (to 
convert old analog videos to DV), 
to a TV, an analog camcorder, or a 
DV camcorder.

3. EyeTV ($189.95)
EyeTV includes a 124-channel 

cable-ready TV tuner and MPEG 
encoder to digitize and send TV 
signals to your Mac over a standard 
USB cable (included). EyeTV 
software displays your TV show 
in a resizable window that you can 
extend the full size of your screen.

4. Borrow or buy a digital 
camcorder with RCA inputs and 
record the sections that you want 
to keep and then import them 
into iMovie. Th en convert them 
using “export for iDVD” to create 
QuickTime movies and then drop it 
onto iDVD to burn.

Charlotte MacWorkshop, 
Charlotte NC

Finding Locate
Q: I need to look for things in Q: I need to look for things in Q:

every folder within the System 
folder, including the Core Services 
directory. But the Finder’s Find 
command doesn’t search all my 
Mac’s folders. How can I search all 
the folders on my Mac? 

—Nicholas White
A: Abandon the Finder’s Find A: Abandon the Finder’s Find A:

command, and use a tool that 
exploits Unix’s Locate command 
that sniff s through the hidden 
database that contains a listing of 
all your Mac’s fi les and directories. 

If you’re allergic to the command 
line, have no fear — I’m not 
sending you to Terminal. Instead, 
travel to www.sebastian-krauss.de/
software and download Sebastian 
Krauss’s free Locator, a utility that 
slaps a friendly interface on the 
Locate command.

Chris Breen’s Mac 911 
via Apple Barrel, Ridgecrest CA

Dump Locked Files Correction
In the March 2005 issue, page 3, 

item “Dump Locked Files”. Maybe 
I should send this to MacAddict 
instead of you, but I found the 
instructions on how to remove 
Locked Files to be incomplete. 
After searching around I did the 
following:
 1. Opened the Hard Drive
 2. Clicked once on the Locked 

fi le
 3. Did a CMD/I
 4. Clicked on Triangle next to 

General
 5. Removed Check mark from 

the box next to the lock
 6. Closed the Info File
 7. Right-clicked on the File that 

is now unlocked
 8. Clicked on move to trash
 9. Emptied the Trash. For those 

of us that are still in the throes 
of learning all about OS

 10. More specifi c instructions are 
very helpful.
John Gorman, Hemet MUG, CA

Is the Bouncing Annoying You? 
UPDATE

Do your icons bounce in the 
Dock while they are starting 
up? You can stop this. In Dock 
Preferences uncheck “Animate 
opening applications.”

I had “Animate opening 
applications” unchecked in my 
Dock Preferences but the Eudora 

icon in the dock still bounced. 
Th is is especially annoying when 
the bouncing occurs because of a 
single spam message sent to my 
junk folder. I didn’t realize in my 
OS X version there is a preference 
category called Getting Attention 
that had among other attention 
getting options the option called 
Bounce the icon in the Dock. 
Unchecking this option eliminated 
the annoyance.

Lynn Rybarczyk

Open Folders
Q: When I’m in the Finder’s 

List view, how can I expand a 
group of folders without having to 
click the little triangle next to each 
individual folder?

A: Highlight all the folders A: Highlight all the folders A:
you want to open, then press 
Command/right arrow to expand 
all of them.

MacAddict Magazine

Why Would You Want 
an LCD Monitor?

Why do you want an LCD 
monitor? Just a few reasons:
• Two times as bright
• Two times as sharp
• Two times the contrast ratio
• Flicker free
• Needs no geometric adjustments
• Uses one-third the power
• Is one-fi fth as heavy
• Has one-third the footprint
• Less likely aff ected by humidity
• Less likely aff ected by heat
• Less likely aff ected by magnetism

Th e only downside is the current 
price. Otherwise, you want LCD!

Mouse Droppings, Corvallis OR

Recycle CDs… 
Don’t Th row Th em Away 

What do you do with your old 
CD-ROMs? Why not recycle them. 
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Here are a few suggestions.
• Coasters — Use a piece of tape to 

cover the center hole.
• Refl ectors — On a rural mailbox 

or as driveway markers.
• Christmas Tree Decorations — 

Glue 2 CD-ROMs with printed 
side together and add string for 
hanger -or- hang CDs outside on 
a tree at Christmas time. Th ey 
can stand up to any weather and 
will refl ect lights.

• Garden Row Markers
• Rifl e Targets
• Sun Catchers
• Mosaic — Break by hand or with 

hammer, glue to board with tile 
mastic, then add grout.

• Mobiles — Hang CDs with string 
or fi shing line and balance from 
hanger, dowels, or branches.

• Clock — Buy battery-powered 
clock workings, use the CD-
ROM for face, then either add 
numbers or leave the face blank.

• Hidden Plug Help — Put double-
stick tape on the non-mirrored 
surface of the CD, line it up with 
the plugs you need to fi nd, and 
attach it to the wall behind the 
appliance to use as a mirror.

• Wall Decorations — Use a tack 
in the center hole or use double-
stick tape to attach them to the 
wall.

• Game Pieces — Make a giant 
checkerboard, 8 squares by 8 
squares. Mark CD-ROMs with 
marker or paint: 12 black, 12 
red. For chess, mark or draw 
chess pieces on blank side of CD-
ROM.

• Carpet Protectors — Place under 
sofa or chair legs to protect 
carpet/rug from furniture indent 
(replaced with CD indent!).

• Disco Ball — Cut into small 
squares or break into pieces. 
Glue pieces onto large foam ball. 

Use unbroken CDs for a HUGE 
disco ball. Hang from ceiling by 
string or wire. Play loud music. 
Dance.

• Scarecrow — Hang CDs in 
your garden to scare away the 
crows. Doesn’t work! But you 
can take several CDs and wire 
them together to look like an 
owl. Hang it so that it moves in 
the breeze. Th is will scare small 
woodpeckers (downy, red-bellied) 
away; keep them from girding 
your favorite trees. It won’t keep 
fl ickers from hammering on 
aluminum downspouts at dawn.

• Bird entertainment — Sometimes 
cardinals and other birds will 
attack their refl ections in a 
window or car mirror. Th is 
makes a mess on the glass. Hang 
up a CD, and birds will attack 
that instead of the window or 
mirror.

• Light switch cover — Use a 
standard light switch cover as 
a template. Cut a hole for the 
switch with Dremel tool or by 
hand with a mat knife or tile 
cutter knife. Drill holes with 
slow drill and sharp drill bit.

• Desk lamp — Stacked CDs with 
neon light at center

• Survival refl ectors — Stow in 
pocket accessible to signal for 
rescue while hiking or boating.

M.U.D. Slinger, Wilmington DE

CD Security
Q: How can I securely burn Q: How can I securely burn Q:

important fi nancial records onto 
CD?

A: Th e easiest method is to use A: Th e easiest method is to use A:
Roxio’s Toast Titanium 6 ($99.95, 
roxio.com) to create 128-bit 
encrypted, password-protected, 
secure CDs. Don’t forget that 
password!

MacAddict Magazine

Out With the Old Ways
Q: My question has to do with Q: My question has to do with Q:

the routine maintenance I used to 
do with OS 9, such as throwing out 
preferences which could become 
corrupted, rebuilding the desktop 
and so forth. I haven’t found how 
to rebuild the desktop in OS 10.2.3. 
Can you tell me if I can still throw 
out preferences? It’s a little more 
confusing now that there are so 
many diff erent preference folders. 

—Barbara Daniels
A: Although they look and A: Although they look and A:

function similarly, OS X is a 
completely diff erent operating 
system from OS 9. Th e customary 
methods of maintaining OS 9 do 
not apply to OS X. In fact, it’s not 
possible to “Rebuild the Desktop” 
under OS X, since it does not have 
the Desktop DF and Desktop DB 
fi les found in OS 9. I’d also advise 
against tossing out preferences 
on a regular basis. Unlike OS 9, 
OS X will not crash (at least, not 
usually) when it encounters a bad 
preference fi le for an application or 
System Preference. In most cases, 
the worst that will happen is that 
the application will unexpectedly 
quit. So, instead of tossing out 
preferences on a regular basis, you 
are better off  waiting until you 
suspect one has become corrupt to 
trash it. Th is will prevent you from 
having to re-enter settings, serial 
numbers and reconfi gure windows 
until absolutely necessary. If you 
want to do routine maintenance, 
I do recommend using Disk 
Utility to Verify and Repair Disk 
permissions on a regular basis.

macHOME HotTips

Alias Your Recent Servers
To make it easier to save or 

open a fi le on a server that is not 
currently mounted, make an alias of 
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the Recent Servers folder, which is 
in the System Folder’s Apple Menu 
Items folder, and put it somewhere 
convenient, such as the desktop. 
Th at way, when you’re in an Open/
Save dialog box, you can easily open 
or save to any server, without having 
to cancel out and open the Chooser 
or Network Browser to mount it.

Design Tools Monthly

Disappearing Hard Drive
Q: I have an iBook running Q: I have an iBook running Q:

OS10.3.5. Every time I shut it down 
and take it home, there’s trouble. 
I get a fl ashing question mark on 
startup, and I’m often unable to get 
any further than that. If I put in the 
Mac OS X Install Disc 1 and try 
to run Disk Utility, my hard drive 
doesn’t show up. I can start from 
another external hard drive, but I 
still don’t see my internal hard drive. 
After several attempts of restarting, 
it will fi nally startup with the 
internal hard drive. I have run 
Drive 10, Disk Utility, Disk Warrior 
and Tech Tool Pro. Everything 
checks out with some “minor” 
repairs. Surface scan show no bad 
blocks. It always works fi ne until I 
shut it down and take it home or on 
a trip. Apple replaced the drive in 
February, and this problem cropped 
up in May. Any suggestions would 
be appreciated —Alex Spassoff 

A: It seems that the trouble only A: It seems that the trouble only A:
occurs when the machine is moved 
around, and that’s a sure sign that 
the problem is hardware-related. 
Th ere is clearly a communication 
problem between the logic board 
and the hard drive, and it’s likely 
due to a loose connection. It could 
simply be that the hard drive cable 
was not properly seated when the 
drive was replaced, and over time, it 
became loose. Now each time you 
move the computer, the cable is 

jostled and the logic board loses sight 
of the drive. Your best bet is to take 
the computer back for additional 
servicing. Apple should be able to fi x 
this issue relatively easily.

macHOME HotTips

Maybe Some Help on Upgrade?
While it is not a sure fi re bet for 

every situation and probably not 
practical for everyone, here are some 
ideas. I have upgraded without 
problems. I am using a G4_dual, 
10.1.4. With the usual gizmos and 
software, Entourage etc.

1. Before you upgrade OS, detach 
all non-Apple stuff  in USB and 
Firewire ports. Remove all hubs 
etc. Non-apple monitors must be 
removed, too. HP printer can stay 
in USB only if it has the current 
HP update. Remove other printers 
if not Apple. DSL modems and 
cable modems are OK if non-apple. 
Th at should leave you only with 
a keyboard the apple mouse, the 
apple etc..

2. Run Disk utilities from the 
CD via OS 9.12 or whatever. Do 
not use OS 10 on the CD. Repair 
Hard Drive. Once Ok’d, run it 
again. Explanation or theory is 
below.

3. Once you pass twice, restart 
from your hard drive OS 10.1.3 and 
install upgrade.

4. Shut down and restart now 
using your upgraded OS.

5. Add one non-apple item at a 
time . once you have added it, do a 
restart each time. (Tedious and may 
not be necessary, but I also root for 
the Red Sox .)

6. When done adding back your 
stuff , do another disk check twice 
as above.

Why? I recall that Unix-based 
systems are layered. Apple’s OS 
must do many writes to disk etc 

to give us all its wonders. Some 
non-apple stuff  and voltage sags 
can interrupt such writes. Th e 
system crashes. You pull the plug. 
Another interrupt. You start it up. 
A device interrupts confounding 
another write to disk etc. Random 
application crashes with more trivial 
failures in writes. Th us. the disk 
repair is done twice to catch the 
stacked up errors etc.

So far I have had no problems 
with upgrades following this ritual. 
I started this after three freezes with 
10.1.3 after it arrived as upgrade. 
Also, I had a nice talk with a real 
Apple guru. But the ritual is my 
notion. Also I suggest a UPS to 
avoid urban and rural power sags. 
I am sorry if all this helps no one. 
But consider this, once running OS 
10.1.4 may not be perfect but it is 
more stable than the other thing.

Michael Zeldin

Mac OS X

FSCK — File System Check
Th ere is a function available in 

OS X that is more sophisticated 
than Disk First Aid for preventing 
problems. It is built into the UNIX 
core and is called File System Check 
(geeks call it fsck). To use it, you 
fi rst have to restart your Mac in 
Single User Mode by holding down 
the “S” key until a load of text 
scrolls down the monitor.

You are now in BSD UNIX.
Don’t panic, just wait until the 

“localhost #” appears and then enter 
fsck -y (the “y” means “yes,” fi x it 
all). Th is will begin an examination 
of everything in your disk. When 
it’s done, it will display one of two 
messages. If you get “Th e volume 
appears to be OK,” just reboot 
and you will fi nd yourself back 
in the Aqua mode. If the message 
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is “Th e File System was Modifi ed” 
you must run the command again. 
Eventually it will repair all damaged 
fi les. Th en reboot (press the Enter 
key) and you are fi xed.

ApplePRESS, Diablo Valley MUG, 
Concord, CA

Key Caps in Panther
Apple has lead us all a merry 

dance with its implementation of 
Key Caps in the various versions 
of OS X. In Jaguar (10.2) it was an 
application, and in Panther (10.3) 
it’s... what?

Th e answer is that Keyboard 
Viewer (neé Key Caps) has joined 
the Character Palette in the Input 
menu, which makes a lot of sense if 
you think about it, and if you know 
what the Input Menu is!

Open System Preferences, and 
click “International.” Click the 

“Input Menu” tab and tick two boxes: 
Character Palette and Keyboard 
Viewer. Also tick the box labeled 
“Show input menu in menu bar.”

When you return to the Finder, 
you’ll see a small “fl ag” icon at the 
right hand end of your menu bar. 
Click this for access to both the 
Character Palette and Keyboard 
Viewer. 

Character Palette is a fascinating 
device worthy of an article of its 
own, and you should really do some 
experimenting with it, but it’s not 
today’s subject.

With Keyboard Viewer open, 
you can see the characters that your 
keyboard will enter using the font 
shown in the pop-up menu. Choose 
a diff erent font from this menu to 
see what its characters look like.

Now press either the Option 
key or the Shift key on your real 
keyboard, and you’ll see the 
characters that will be entered if 
you hold down that key as you 

type. Note that holding them 
both down reveals another set of 
characters again. 

Note further that not all fonts 
contain exactly the same set of 
characters, although most do. Now 
you know how to fi nd out the 
key combination to use to type 
any character in any of your fonts. 
Further, you can enter any character 
into the current document by 
clicking its key in Keyboard Viewer.

While holding down the 
Option key, you’ll notice fi ve keys 
that acquire thick borderlines, 
and which display accent marks. 
Clicking any of these keys “enters” 
the accent mark though nothing 
appears in your text. Release the 
Option key and type any character 
to which the accent in question is 
normally applied, and your accented 
character will appear.

As an example, to type an “o-
circumfl ex,” fi rst hold down the 
Option key and type an “i”; then 
release the Option key and type an 

“o”. You can see from the Keyboard 
viewer that typing Option/i 
registers the circumfl ex accent, and 
typing the plain “o” tells the Mac 
to apply that accent to the letter “o”. 
Similarly, Option/n plus “n” gives ñ 
and Option/’ plus “a” gives â.

Now for the real fun. Open 
Character Palette and explore 
its tabs and pop-up menus. One 
hint — depending on the program 
you’re using, you may have to 
change the font in that program 
to correspond with your desired 
character, before “inserting” the 
character from the Palette.
AUSOM News, Melbourne Australia

What’s Up, Dock?
I have so many things in my 

OS X dock that the icons are 
tiny. I use the dock so much that 

it has become second nature, so I 
was surprised when I talked to a 
customer who had upgraded to OS 
X and confessed to never using the 
dock at all. In fact, he asked me 
how to get rid of the dock entirely. 
I am not going to talk about 
eliminating the dock, but rather 
about how the dock is a useful tool.

When you install a fresh version 
of OS X or get a new machine, you 
will fi nd the following icons in 
your dock:
 1. Finder
 2. Mail (if there is a red number 

on the Mail icon, it means you 
have new messages)

 3. Safari
 4. iTunes
 5. iMovie
 6. Sherlock
 7. QuickTime Player
 8. System Preferences
 9. Dock Separator (a thin white 

line)
 10. URL icon (this is set to go to 

Apple’s OS X Product page, but 
you can set it to be any URL; 
see below)

 11. Trash
Small Dog Electronics 

Phoney Setup
Some folks in Macworld’s OS 

X forum are scratching their heads 
about how to record telephone 
conversations in Panther. Th e 
couple of people who’ve tried have 
encountered more-than-distracting 
hum and background noise. For 
help I turned to two folks who do 
this kind of thing on a regular basis.

Th ose two are hosts of two 
Macintosh-focused Internet radio 
shows — Shawn King of Your 
Mac Life http://www.yourmaclife.
com/ and Gene Steinberg of Mac 
Nightowl Live http://www.macradio.
com/friday/.

http://www.yourmaclife.com/
http://www.macradio.com/friday/
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Shawn reports that in his 
early days of online broadcasting 
(before he had the budget to hire 
professional audio engineers to do 
the job), he’d use a speakerphone 
and point a microphone at it. He 
cautions that if you go this route, 
you use a full-duplex speakerphone 
— one that ensures that the voice on 
the other end of the line isn’t muted 
when you talk over it.

Gene off ers similar advice. He 
uses a high-grade speakerphone, a 
microphone, and an OctiVox Clear 
Call a $180 device that maximizes 
the audio output of the call so 
it’s suitable for broadcast. Gene 
suggests that if you’re willing to use 
a go-between device for recording 
conversations, you visit Ahern 
Communications’ site.

Chris Breen’s Mac 911 
via Mouse Droppings, Corvallis OR

Easily Lock an Item
Select the item and press 

Command/I. Lock it in the 
“Locked” checkbox.

Mouse Droppings, Corvallis OR

Hate the Word “Alias” on your 
Aliases?

You don’t need it, since each alias 
in OS X has a little arrow in lower 
left corner of the icon. Command/
Option/drag a fi le from its current 
window onto the desktop and it 
leaves the word “alias” out.

Mouse Droppings, Corvallis OR

Zoom In on Anything 
in Mac OS X

Mac OS X 10.2 has a Universal 
Access item in its System 
Preferences panel. If you click 

“Turn on Zoom,” you can then 
press Option/Command/plus sign 
(+) to zoom in to anything on your 
display, including Web pages, word 

processing documents, and other 
diffi  cult-to-zoom items. Each time 
you press Option/Command/plus 
sign (+) you will zoom in a bit more. 
Use Option/Command/minus (-) to 
zoom back out.
 —Deborah Shadovitz

Mac Design 
via Design Tools Monthly

Quick Dock Access from 
Anywhere

You never need to bother leaving 
the current application just to 
access the contextual menus of 
the Dock. Just Control/click on 
the application’s Dock item and 
you can bring up the contextual 
menu without leaving the current 
application. 

For instance, you can quit an 
application or choose the next song 
from the iTunes dockling.

Mouse Droppings, Corvallis OR

Collapsing All Open Windows
Holding down the option key 

and double-clicking the title bar of 
a true Cocoa-built application (and 
some Carbon apps) will collapse 
all of the open windows, similar to 
the window shading eff ect utilized 
in Mac OS 9. Th is works in Safari, 
iChat, and other Apple iApps.

MacFixIt

Kill the Process
Another useful function in OS X 

is the UNIX command to kill the 
process. In Applications (for OS X), 
you will fi nd an item called Process 
Viewer. Once selected, it will list all 
processes currently running and you 
can force any one or all of them to 
quit by simply double-clicking the 
item or items and then clicking the 

“Force Quit” button.
ApplePRESS, Diablo Valley MUG, 

Concord, CA

What’s Open?
You can see a list of all the 

documents an application has open 
in the Dock. Just hold down the 
mouse button while its pointer 
is over the active application in 
question in the Dock. A list of open 
documents will appear and you can 
select the one you would like to 
have come up.

MacPac, Ponca City OK

Favorites in the “Save Sheet”
If you want to fi le an item in 

one of your Favorite folders, click 
on the pop-down in the Save... 
sheet and your Favorites appear 
just below the grayed out Favorite 
Places. (Only Cocoa applications 
have the Sheet feature. Carbon 
Applications use the old-style 
dialog boxes without Sheets.)

Mouse Droppings, Corvallis OR

Mind the Finder
One of the most noticeable 

diff erences between OS 9 and OS X 
is the way folders are opened. 

In OS 9, double-clicking a folder 
opens a new window that displays 
the contents of that folder. In OS 
X, double-clicking a folder displays 
the contents of that folder within 
the same window, eliminating the 
previous contents. Th is can take 
some adjustment for new users.

Th ere are several workarounds, 
however. You can hold down 
the command key when double-
clicking a folder to force a new 
window to open. Th ose of you 
who genuinely prefer OS 9’s 
folder behavior can make a more 
permanent change: Select Finder 
> Preferences, check the option 
to “Always open folders in a new 
window,” and close the window. 
Th ings will now be back to normal.

macHOME HotTips
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Pre OS X

Old Mac OS Software
For those of you who may have 

a need for some (really old) Mac 
OS systems, enter this address 
in your browser and you’ll be 
able to download versions as old 
as System 6.0.3, and as recent as 
System 7.5.3. ftp://ftp.info.apple.com/
Apple_Support_Area/Apple_Software_
Updates/English-North_American/
Macintosh/System/.

MacVIEWS, Ft. Wayne IN

Apple Menu Tricks
You have your nice multicolored 

Apple menu and you’d like to add 
more stuff  to it. But to do so, you 
must open the hard drive, then 
locate and open the System Folder, 
and THEN locate and open the 
Apple Menu Items folder, and 
THEN move the window over, and 
THEN make an alias of what you 
want to put in there, and THEN 
drag it in, and THEN close all of 
the windows. What a pain! 

Try this instead: Open your 
System Folder and locate the Apple 
Menu Items folder and click on it 
once. Make an alias of this folder, 
name it Apple Items, and place the 
alias INSIDE the Apple Menu Items 
folder and close all windows. Now 
when you want to add something to 
the Apple Menu, head to the Apple 
menu and choose Apple Items. Th is 
will open a window, so just drag 
in what you want and close the 
window. Job done.

Th e Finder, Mid-Columbia MUG, 
Kennewick WA

Internet

Tab Backwards
When I am tabbing through the 

URL bar, Google search box, and 

bookmarks, and have gone past the 
link I am after, (and am too lazy 
to reach for the mouse), instead 
of tabbing through all of the links 
again, hold shift, and press tab to 
go through in the reverse order.

Andrew Patton

Th inking of a Cable 
or DSL Internet Connection?

You will need an Ethernet 
port on your Macintosh. Many 
Cable and DSL providers do not 
know anything about Macs. Th is 
sometimes causes problems at 
install time. All new Macs and 
some older Macs computers have 
the built-in Ethernet connection 
that Cable or DSL needs. Some 
older Macs are equipped with an 
AAUI Ethernet port. You will need 
an Ethernet Transceiver to make 
your Macintosh work with the 
Cable or DSL connection. Th ey run 
about $29.

Some of the older Macs have no 
Ethernet ports. In most cases, some 
type of card can be purchased to 
make your older Macintosh have 
the correct Ethernet connection. 

You can check the Specifi cations 
pages of the Apple Web site www.
apple.com to see what type of 
Ethernet connection you have.

Mad Mac News, Madison WI

Application Hotkeys
OS 9 allows you to map an 

application or document to a 
function key for quick access. So, 
if you wanted to open Internet 
Explorer without having to search 
for the application, you could 
simply establish F1 as your Internet 
Explorer hotkey. 

To assign a hotkey, open the 
Keyboard control panel. Click 
Function Keys to open the Hot 
Function Keys window. Check 

the fi rst option to ensure you use 
F1 through F15 as Hot Function 
Keys, and then move down to Hot 
Function Key Assignments. 

Now, locate an application in 
the Finder and drag it into the text 
box adjacent to the function key of 
your choice. 

Assign function keys to other 
applications as you like. Click OK, 
close the window and then close the 
control panel. You’re now ready for 
a test run. 

Click a function key to instantly 
launch an application. Th ere’s 
no longer a need to sift through 
window after window looking for 
the application icon!

macHOME HotTips

Searching Google 
by the Numbers (Continued)

In addition to entering the things 
you mentioned in the April issue 
(UPS, patent numbers, et al.) if you 
enter the letters UPC and a space 
and then the UPC code you can 
fi nd out what the item is.

UPC 86279007759 took me 
to the Cuisinart Griddler electric 
griddle.

Ray Schuerger, the Sauer Kraut

Google Mapping
Check out the new mapping 

service from Google. It is fast and 
after you fi nd the address, you can 
click on “Satellite” and get an actual 
photo. http://maps.google.com/

Judson LaFlash, 
Government Marketing Company

Google: Are You Using It 
To Its Fullest?

A search engine is a program 
that searches for specifi ed keywords 
and returns a list of the documents, 
or Web sites, where the keywords 
were found. Alta Vista, Google, 

ftp://ftp.info.apple.com/Apple_Support_Area/Apple_Software_Updates/English-North_American/Macintosh/System/
http://www.apple.com
http://maps.google.com/


May 2005 • Page 9www.mac-hints-tips.com

and Ask Jeeves are examples 
of search engines that look for 
documents/subjects on the Internet. 
Some defi nitions of Google refer 
to it as a verb, such as “Google 
it, now.” Time after time Google 
(www.google.com) shows up as 
one of the best. But are you using 
it to its fullest? Th ere are so many 
ways to search on Google. Did 
you know that if you type “one 
decade in seconds” (without the 
quotes) that you will get the answer 
(315,569,260).

Calculator. To use Google’s 
built-in calculator function, simply 
enter the calculation you’d like 
done into the search box and hit the 
Enter key or click on the Google 
Search button. Th e calculator can 
solve math problems involving basic 
arithmetic, more complicated math, 
units of measure and conversions, 
and physical constants. To learn 
how to use the calculator go 
to http://www.google.com/help/
calculator.html.

Google Made Easy. Go to http://
www.google.com/options/index.html
and use the categorized icons.

Doodles. If you want to see 
some of the fi rst Google logos or 
doodles go to http://www.google.
com/holidaylogos99.html. Dennis 
Hwang is the fella that draws the 
doodles and has produced almost 
150 of them. He actually is Google’s 
international webmaster. If you 
want to suggest a theme for a 
Google doodle send him a note at 
doodle@google.com

Games on Google. Just type in 
Google Games in the search engine 
and you’ll fi nd that many people 
have created games to be played 
with Google. I discovered one called 
Googlewhacking. It was mentioned 
on the NBC Today show a couple 
of weeks ago. It’s played this way: 

you think of two words and type 
them in the search box. Th e idea is 
to get the resulting web sites down 
to ONE. Yes, one. Th is is more 
diffi  cult than it sounds. It took me 
a while to do it but I got it. Finding 
NONE doesn’t count. Got to get 
it down to ONE. Let me know if 
you get it and what words you used. 
Next month I’ll tell you which 
ones I used. I will tell you though 
that Cruciate olives got 65 results. 
Now, that’s a pretty low count. And 
wireless pizza got 1,320,000 results. 
Go fi gure!

Compare Search Engines. You 
might want to try another search 
engine such as Yahoo or Alta 
Vista or Teoma. Check out the 
Noodletools site to compare search 
engines and you decide which one 
is best for you. I think you’ll agree 
that Google is the best. 
http://www.noodletools.com/debbie/
literacies/information/.

— Virginia Chilcote
MouseBytes, St. Petersburg, FL

Internet Explorer

Digging Th rough Directories
To easily move through various 

layers of a website using Internet 
Explorer 5, Command/Click in the 
browser’s titlebar. 

When you do you’ll be presented 
with a pop-up menu of all the layers 
between the page you’re on and the 
home page of that site. 

Note: You must click in the title Note: You must click in the title Note:
area itself, not simply on the titlebar.

NotePad, Springfi eld IL

Internet Explorer Hold the Page
Th e Page Holder tab on the 

left hand side of IE allows you to 
temporarily “hold” a page while 
searching another page. Th is works 
great when using search engines. 

You place the search results in the 
Page Holder and then click on 
the links to see the results in the 
main window. Better than the back 
button!

Th e Finder, Mid-Columbia MUG, 
Kennewick WA

Safari Status
Q: I live by Safari’s status bar at Q: I live by Safari’s status bar at Q:

the bottom of the window, but it 
disappeared! How do I get it back?

A: We’re amazed that this option A: We’re amazed that this option A:
isn’t just always on, but you can 
toggle it on and off  by selecting 
View > Status Bar. Even quicker, use 
the keyboard shortcut Command/
forward slash (/).

MacAddict Magazine

Preserving Bookmarks 
Across the Switch

If you browse the Web using 
Internet Explorer in both Mac OS 
X and in Classic, you may have 
cursed the inconvenience of having 
to maintain two separate lists of 
favorite Web sites — and of having 
to lose your history trail every time 
you switch from one browser to the 
other. Fortunately, you don’t have to.

All you have to do is replace your 
Mac OS X Favorites and History 
fi les with aliases of your Mac OS 9 
Favorites and History fi les.

Open your Mac OS 9 System 
Folder (the one you’ve selected for 
use in the Classic mode. Open the 
Preferences > Explorer folder. Inside 
are two critical fi les: Favorites.html 
(your bookmarks) and History.html 
(the list of Web sites you’ve visited 
recently). Create aliases of them on 
the desktop; the easiest may is to 
Command/Option/click and drag 
them there.

Th e next task is to put them in 
the right place in your Mac OS X 
world. Start by opening your own 

http://www.google.com/help/calculator.html
http://www.google.com/options/index.html
http://www.google.com/holidaylogos99.html
http://www.noodletools.com/debbie/literacies/information/
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Home folder (choose Go > Home 
or press Command/Option/H). In 
it, open the Library > Preferences 
folder. Drag your two aliases 
(Favorites.html and History.html), 
onto the Explorer folder icon. Mac 
OS X asks you if you’re sure you 
want to replace the existing fi les of 
the same names. You are.

Th at’s all there is to it. Whenever 
you use Internet explorer, whether 
in Mac OS X or in Classic, you’ll 
see the same, up-to-date set of 
favorites (bookmarks), and your 
history list will always be current.

David Pogue’s Mac OS X: 
Th e Missing Manual

Photoshop

Preview Color Channel 
in Full Color

When one of the separated 
color Channels is active in the 
Channels palette, pressing “~” will 
keep the color Channel active but 
preview the full-color image in the 
Photoshop window. 
—Katrin Eismann

Photoshop User Magazine

High Pass Sharpening
In addition to Photoshop’s USM 

Filter, another useful technique 
is using the High Pass Filter. For 
this, you’ll need to duplicate either 
your background or your visible 
layers. On this additional new layer, 
set the blending mode to ‘Overlay’. 
It’ll look a little weird (don’t worry, 
you’ll fi x that in a minute). 

Th e next step is to run the High 
Pass fi lter on this layer. You’ll fi nd 
it under Filter/Other/High Pass. 
You’ll want to select a radius that 
represents about 1/100 of an inch 
on your fi nal image. So, if your 
image were set to 300ppi, the radius 
would be about 3 pixels. You’ll need 

to adjust this up or down based 
upon your image and its sharpening 
requirements. 

Remember to look at the image 
at 50% zoom to determine the 
amount of sharpening required. 
Also, since this is a separate layer, 
you can reduce the overall opacity 
of the layer to reduce any over-
sharpening or use a layer mask to 
localize the results.

AvondaleMedia.com

Permanently Hide Slice Numbers
To hide the slice numbers in 

a more permanent way, press 
Command/K to open the 
Preferences, and then go to Guides, 
Grid & Slices. At the bottom of that 
dialog box, uncheck the “Show Slice 
Numbers” box. —Dave Cross

Photoshop User Magazine

3D Objects for Collages
Take a look at the trendy “Euro 

collages” and you’ll often see 
some 3D objects included. To 
quickly create a funky-looking 3D 
object, try this: On a new layer 
with nothing selected, use Filter > 
Render > 3D Transform. 

With the Cube tool, draw a 
bunch of overlapping boxes — the 
more the better. Th en use the 
Trackball tool to rotate the object 
until you see shading on each side. 

Click “OK.” Scale, copy, 
change the Blending Mode, fl ip 
vertical - whatever you want, then 
incorporate the object into your 
artwork. —Dave Cross

Photoshop User Magazine

Get Rid of the 
Multi-Color Speckles

Q: Is there a way to get rid of the Q: Is there a way to get rid of the Q:
multi-color speckle you get when 
you import an image from digital 
video? —Liz

A: Th e same thing happens when A: Th e same thing happens when A:
you scan photographic negatives. 
Here’s how I get rid of it: Choose 
Filter > Blur > Gaussian blur and 
experiment until all those multi-
colored specks blend into the image 
(don’t worry if the image looks 
blurry overall). Right after applying 
that fi lter, choose Edit > Fade and 
then change the pop-up menu from 
Normal to Luminosity. Th at’s it!

Ben Willmore’s digitalmastery.com

Accessing Transform Handles
Scaling down a large image when 

you drag it into a smaller image 
for compositing can be frustrating, 
because the transform handles are 
often outside the smaller image area. 

To access the handles quickly, 
press Command/T to activate the 
Transform bounding box, and then 
press Command/0 (zero). 

Th is changes the image 
magnifi cation and expands the 
document window so you can see 
the transform handles in the gray 
area around the image. 

Photoshop User Magazine

Visually Grow Canvas
In Photoshop you can increase 

the size of your canvas visually, 
rather than through the Canvas 
Size dialog box: use the Crop tool 
to create a crop selection, then drag 
the cropping handles out beyond 
the edge of the canvas. Th e canvas 
will grow to accommodate.

Design Tools Monthly

Choose the Best Profi le
Often, someone sends me an 

image where Photoshop complains 
that the image is untagged and 
asks me to assign it a profi le. Th e 
problem is that I don’t know which 
profi le would make the image 
look its best. When that happens, 
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just click the OK button and then 
choose Image > Mode > Assign 
Profi le. Th en try the four profi les 
that show up at the top of the 
Profi le pop-up menu to see which 
one makes your image look the 
best. Th at way you can see the 
consequences of your action instead 
of “working blind” by assigning a 
profi le before the image has even 
had a chance to open.

Design Tools Monthly

Easier Text Selection
In Photoshop 6 & 7, you can 

instantly switch from any tool to the 
Type tool and highlight all the text 
on a layer by double-clicking on the 

“T” thumbnail on the appropriate 
Type layer in the Layers palette.

Design Tools Monthly

Choose Mode for Solid Color
To speed up hand-coloring work, 

press Option adding a new Solid 
Color Adjustment Layer from the 
Layers palette. Th is brings up the 
New Layer window where you 
can change the Blending Mode to 

“Color” before selecting the color in 
the Color Picker. —Katrin Eismann

Photoshop User Magazine

Auto Levels Help
Sometimes Auto Levels, applied 

in a Levels Adjustment layer, almost 
works but not quite. Here are two 
things to try, separately or together:
• If Auto Levels, applied in a Levels 

Adjustment layer, improves the 
contrast of an image but actually 
makes a color cast worse, just 
click OK to accept the result and 
then set the blend mode of the 
Adjustment layer to Luminosity.

• If Auto Levels does too good a 
job and the image now looks 
like it has an unnatural amount 
of contrast, simply reduce the 

Opacity of the Adjustment layer, 
thereby reducing the intensity of 
the contrast adjustment.

Linnea Dayton & Jack Davis’ 
Th e Photoshop Wow! Book, 
via Design Tools Monthly

Preset Manager Preferences
Photoshop’s Preset Manager has 

a separate Preferences fi le for each 
of its eight palettes. You’ll fi nd these 
.psp fi les in the same folder as the 
Photoshop Preferences fi le. Delete 
fi les individually to reset those 
particular Preferences. Deleting the 
Adobe Photoshop 7.0 Preferences 
fi le resets all eight panes (as well as 
lots of other settings). —Peter Bauer

Mac Design Magazine

Photoshop 7.0 Bug
In Mac OS X, when the 

preferences for Photoshop 7.0 are 
changed to use volumes other than 
the startup volume for scratch 
disks, Photoshop will fail to start up 
because it does not have suffi  cient 
permissions to create temporary 
fi les. Dragging the preferences 
fi le in the trash and restarting 
Photoshop will create a new default 
preferences fi le. Th ere is no problem 
changing preferences other than 
scratch disks.

Ric Ford’s macintouch.com

TextEdit

Save TextEdit Docs from 
Changes

TextEdit, a Mac OS X 
application, can open text fi les 
larger than 32K. TextEdit will only 
create RTF (Rich Text Format) 
fi les, not ASCII fi les. You can open 
SimpleText documents in TextEdit. 
If you save the document, TextEdit 
saves the document in RTF 

format. To protect your TextEdit 
documents from being changed, 
you can make them “Read Only.” 
Th is means that other people cannot 
automatically change the document. 
To accomplish this, open the 
document in TextEdit and choose 

“Make Read Only” from the Format 
menu. To change the document, 
choose “Make Editable” from the 
Format menu.

MacPac, Ponca City OK

Use Summarize Function 
to Tidy Up Text

Summarizing text at 100% will 
remove unnecessary white-space 
and new lines, whilst leaving the 
text otherwise unaltered. Select the 
text to be tidied, then “Summarize” 
from the Text Edit menu item. Set 
the slider to 100% and copy the 
summarized (cleaned-up) text back 
over the original document text. 

—Adrian Mayo
OSXFAQ

Laptops

I Feel So Drained Th ese Days!
If you are experiencing 

mysterious power drains on your 
PowerBook when running on 
battery power while it is (or should 
be) sleeping, check your mouse. Th e 
drain could be because the mouse is 
waking it up — even while the cover 
is closed. Be sure to disconnect any 
external pointing devices before the 
machine is put to sleep.

Charlotte MacWorkshop, 
Charlotte NC

15-inch PowerBook Extension
Eff ective immediately, Apple is 

introducing the 15-inch PowerBook 
G4 Display Repair Extension 
Program covering replacement of 
the LCD in a limited number of 
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PowerBook G4 15-inch models 
that show faint white spots on the 
display. Th e aff ected PowerBook G4 
15-inch models were manufactured 
between July 2003 and November 
2003. Here is the link: http://www.
apple.com/support/powerbook/
displayprogram/.

Charlotte MacWorkshop, 
Charlotte NC

Illustrator

Cropped EPS fi les
If your Illustrator fi les are 

coming into other programs slightly 
cropped, in Illustrator, place a box, 
with a fi ll and stroke of None, just 
outside the edges of your art. Save 
and re-import or update the fi le in 
the other program.

David Creamer of I.D.E.A.S.

Modifi er Keys Stop Working
If your modifi er keys stop 

working (Shift and Option), turn of 
the Input Menu Shortcuts. It can be 
found in the International System 
Preferences; under the Input Menu 
tab, click on the Options button. 
You must log out and back in again 
for the settings to be active.

David Creamer of I.D.E.A.S.

Extra Styles in Illustrator
Illustrator 9 and 10 include 

several additional libraries 
of predefi ned Styles for the 
Appearance palette. To load them, 
choose Window > Style Libraries. 
You can use them to learn about 
how Styles are constructed, or for 
instant use. Just apply an interesting 
Style to an object, then click on its 
layers in the Appearance palette to 
see how it’s constructed. Double-
click on any of the style’s Eff ects 
attributes to see the settings.

Design Tools Monthly

QuarkXPress

Controlling the Kerning
To decrease or increase the space 

between letters in a text box, hold 
down Shift/Option/Command 
and hit the “[“ key to tighten up 
the letters. Hold Shift/Option/
Command and hit the “]” key to 
add some air between letters. When 
you select a paragraph, it’s a great 
way to add or subtract some space 
from text to fi t or fi ll a page if you’re 
running too long or short on a story. 

—Angus McKelvey
Mac Design Magazine

Open DTP Pages in Photoshop
Saving your PageMaker or 

QuarkXPress page as an EPS fi le, 
or by creating a postscript fi le from 
it, allows you to open the fi le in 
Photoshop. Just drag-and-drop 
the fi le onto the Photoshop icon, 
or open it from within Photoshop 
(File > Open).

MacVIEWS, Ft. Wayne IN

Th e Th in White Line
If your picture boxes have a 

rule, always try to make an image 
slightly larger on all four sides than 
the picture box containing it. Th at 
way you won’t get a thin white line 
between the frame and image when 
it prints. Even if you zoom in 800%, 
you still might not see the white line.

David Creamer of I.D.E.A.S.

Color Management
Unless you carefully set up 

profi les for your scanner, monitor, 
proofer, and printer, you may not 
want to use Quark’s built-in color 
management. Turn it off  and 
work in a strict CMYK mode in 
Photoshop, Illustrator, and Quark 
until you are calibrated and profi led.

David Creamer of I.D.E.A.S.

Selecting a Hidden Object
If you want to select an object 

that’s hidden under several objects 
in front of it, hold down the Shift/
Option/Command key and click 
on the stack of objects to circulate 
through them until you can see the 
object you want to select. 

—Angus McKelvey
Mac Design Magazine

InDesign

Palette Keyboard Shortcuts
Align ...........................................F8
Character ................... Command/T
Character Styles ............... Shift/F11
Check Spelling ............Check Spelling ............Check Spelling Command/I
Color ...........................................F6
Find/Change .............. Command/F
Index ..................................Index ..................................Index Shift/F8
Layers ..........................................F7
Links ................ Command/Shift/D
Pages .........................................F12
Paragraph ..................Command/M
Paragraph Styles ........................ F11
Stroke .......................................F10
Swatches .....................................F5
Table ..................................Shift/F9
Tabs ..................Command/Shift/T
Text Wrap ....Command/Option/W
Transform ...................................F9
Transparency ....................Transparency ....................Transparency Shift/F10

Real World Adobe InDesign 2

Show Options Shortcut
Hold down Shift and double-

click a text fi le in the Place dialog 
box, or hold down Shift as you 
click the Choose/Open button, and 
InDesign will display the “Import 
Options” dialog box for the type of 
fi le you are importing.

Real World Adobe InDesign 2

A Taller Pasteboard
If you like to have more 

pasteboard space around your 
pages, open the Preferences dialog 

http://www.apple.com/support/powerbook/displayprogram/
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box (Command/K) and choose the 
Guides & Pasteboard panel (press 
Command/6). Now change the 
Minimum Vertical Off set fi eld to 
the size you want and click OK.

David Blatner’s Tips & Tricks 
by ALAP, Inc.

Use New Window
When you choose Window > 

Arrange > New Window, InDesign 
opens another window for your 
document. Each window can show 
a diff erent part of your document. 

For instance, you could have 
one window display the fi rst page 
at Fit in Window view and have the 
other window display the last page 
at 200%. Make an edit in the fi rst 
window, and you’ll soon see how 
that edits aff ects the last page in the 
other window! 

Try using New Window three 
times; after the third time, you’ll 
become hooked and want to use it 
all the time!

David Blatner’s Tips & Tricks 
by ALAP, Inc.

Acrobat

Distiller Settings
If you use Acrobat Distiller 

to create PDF fi les, then you’ve 
probably made custom settings. Th is 
overlooked feature of Adobe Distiller 
will add to your PDF production.

As a person who makes PDF fi les 
all day every day, controlling the 
many settings in Acrobat Distiller 
can be a real problem. Distiller is 
the software part of the Adobe 
Acrobat package that actually 
creates PDF fi les. 

Th is all-important software 
is in fact a software RIP, similar 
to the controller on a PostScript 
printer, but its end product is a self-

contained PDF document instead of 
a printed page.

At last count there were 
1,239,864 variables in Distiller 
(perhaps a conservative count 
-– experts cannot agree on the 
actual number), and if you set 
one incorrectly, the resulting fi les 
are not useful: Th ey don’t print 
correctly, or they don’t have the 
correct font implementation, or the 
color space is wrong, or….

LIMac Forum, Long Island, NY

Custom Settings
In Acrobat Distiller 6.0, which 

comes with Acrobat 6.0 Professional, 
the fi ve available default settings 
(High Quality, PDFX1a, PDFX3, 
Press Quality, and Standard) are 
usually not acceptable to me. 
Adobe has created these to answer 
the needs of the general public 
(“Standard”) and the publishing 
professional (PDFX1a), but for the 
work I do there are often things that 
I need to change. For example, I 
fi nd myself changing the percentage 
for sub-setting embedded fonts, or 
changing the compression values or 
compression method for images in 
PDF fi les.

For instance, I always set all fonts 
to embed Acrobat Tips: Applying 
Custom and to subset at a fairly 
high percentage value. I do this to 
force Distiller to create a custom 
font name for the embedded font 
(this solves an esoteric problem 
with RIPs that have resident fonts 
with the same names as the fonts 
I have on my computer). On the 
issue of compression, I usually 
choose not to use JPEG (the default) 
as the compression method for 
color images in PDF fi les destined 
to high-quality printing. Since 
JPEG creates often-visible artifacts 
in images, I choose either no 

compression or ZIP compression, 
which is lossless. I also do a fair 
amount of work that is printed 
on newsprint, so I have made 
special PDF settings for newsprint 
(resolution appropriate for 100-lpi 
halftones).

Whenever I make these changes 
to Distiller settings, I know I can 
save them and use them again. In 
earlier versions of the application 
these custom settings used to be 
called Job Options. But in Distiller 
6.0, the menu item entitled PDF 
Settings takes you to a multi-
tab menu where these items are 
controlled, although the resulting 
fi les are (still) called .joboptions by 
Distiller. By default, Distiller will 
put your settings with the defaults 
that Adobe provides. When you 
save your .joboptions fi les with 
Adobe’s, your settings will show up 
in the menu of Adobe PDF Settings 
that control how your PDF fi les 
will be made. Each time you use 
Distiller you must ensure that the 
correct selection is made before 
invoking the application. If you 
don’t do this, you can easily get a 
PDF with the wrong attributes (not 
enough compression, wrong color 
space, no embedded, etc.).

LIMac Forum, Long Island, NY

Search PDFs
You all have an extensive 

Macintosh helper located on your 
hard drive. Do you keep all your 
Mac Hints & Tips in electronic 
Acrobat Reader format somewhere 
on your hard drive? Th ey are 
searchable with Acrobat Reader 6. If 
you are using OS 10.2.2 or higher, 
you can download Reader 6 free 
and it works in this kind of search.

Using the “Search” menu item, 
type in the character string you wish 
to fi nd. Reader locates all matching 
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character strings. It works all the 
way back to the fi rst electronic issue 
of Mac Hints & Tips.

And remember, Reader can search 
for a character string located in 
any PDF located anywhere on your 
hard drive. You do not even need to 
gather your PDFs into a single folder 
to do this. Just tell Reader to fi nd 
the character string in any PDF on 
your entire hard drive.

Mouse Droppings, Corvallis, OR

Specifi c PDF Page
On a Web page, you can link to 

a specifi c page in a PDF document 
(rather than to page 1 of the PDF) 
by adding “#page=XX” (without the 
quotes) after the URL of the PDF 
fi le, where XX is the page number. 

For example, “/PDFs/this_fi le.
pdf#page=32” to open to page 32 of 
this_fi le.pdf, which is in the PDFs 
directory.

Design Tools Monthly

Distributed Distilling
Th is arrangement looks 

complicated, but the eff ectiveness of 
this method is solid. If you save or 
move a PostScript fi le to the correct 
folder, the resulting PDF will be 
created correctly (you can’t make a 
mistake very easily, and if you do, 
just drag the .ps fi le into the correct 
folder and do it again).

Being the evangelist that I am, I 
have created this folder arrangement 
on a variety of colleagues’ 
computers, and since I never hear to 
the contrary, I must assume that it 
is working successfully.

I have tested this technique 
thoroughly with Distiller 5 and 6. 
With version 6, I can even update 
the .joboptions fi les from the 
Watched Folders palette. For each 
watched folder there is an associated 
Settings fi le. On the right side of 

the Watched Folders menu are 
buttons for editing, loading, and 
clearing the settings fi les. I can also 
add security settings for those PDFs 
that need password protection or 
other restrictions. Th en, by simply 
saving my PostScript fi les into the 
correct folder, these security settings 
and all my PDF Settings will be 
applied according to these Watched 
Folder controls.

If you distill a lot of PDF fi les, 
try this technique. You’ll be pleased 
with its effi  ciency. —Brian P. Lawler

LIMac Forum, Long Island, NY

Combining Multiple PDFs
OS X’s integration of PDF 

technology is a winner. Most 
folks can forget totally about the 
megabucks required to buy Adobe 
Acrobat for the creation of PDF 
documents. All that’s necessary to 
do this is to print a document, but 
choose “Save as PDF” rather than 

“Print” in the normal print dialog.
One problem may arise, though. 

How can you combine two PDFs 
already created, or rearrange the 
pages in one that you have?

Freeware to the rescue 
Christian Schmitz’s “Combine 

PDFs” allows you to do just that. 
How easily? Here is the complete 
documentation for the program:

“Drop some PDF or picture fi les 
on the application or the main 
window. Reorder or remove pages 
as you want. Enter some meta 
information like the Title and 
save the new PDF. Analyzing and 
processing of PDFs may take a 
while....” Is that simple enough?
AUSOM News, Melbourne Australia

PDF Toolbar in Microsoft Offi  ce
If you have Acrobat 6 

Professional and Microsoft Offi  ce 
X, Acrobat installs a small Acrobat 

PDF toolbar in Excel, PowerPoint 
and Word. At best, creating a PDF 
using these buttons takes far longer 
than using the Adobe PDF print 
driver, and at worst this toolbar 
can become corrupt and cause 
problems in Offi  ce applications. To 
delete the toolbar, search your Mac 
for all instances of PDFMaker.xla, 
PDFMaker.ppa and PDFMaker.dot 
and delete them.

Macworld Magazine 
via Design Tools Monthly

How to Fix the 
Most Common PDF Mistakes

What are the most common 
mistakes people make when 
creating PDFs that make them 
less usable? Here are several. For a 
complete rundown, check out Carl 
Young’s new book “Adobe Acrobat 
6.0: Getting Professional Results 
from your PDFs”:

1. Can’t navigate around a long 
PDF, except using page down 
and up? Chances are you have a 

“Lost In Space” PDF. Th e fi x? Add 
bookmarks and hyperlinks.

2. Is your 10-page PDF destined 
for simple on-screen viewing larger 
than 1MB? Th at would be a “Fat 
Albert” PDF. Th e fi x? Downsize fat 
graphics.

3. If your long PDF takes forever 
to open when downloading, you’ve 
made a “Waiting Game” PDF. Th is 
one’s easy to fi x by enabling “Fast 
Web View” in Document Properties.

LIMac Forum, Long Island, NY

Dreamweaver

Clean Up Th at FrontPage HTML
Raise your hand if you hate the 

code that Microsoft FrontPage 
creates. Okay, put your hand 
down, you look ridiculous. Get 
rid of all of the proprietary code 
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that FrontPage slathers into their 
HTML code (adding to the fi le size, 
mind you!) by installing the Clean 
Up FrontPage HTML extension 
from Macromedia Exchange 
(www.macromedia.com/exchange/
dreamweaver). —Rick Tracewelldreamweaver). —Rick Tracewelldreamweaver

Mac Design Magazine

Insert a JavaScript 
Rollover Image

Place your cursor where you want 
the image to appear. Choose Insert 
> Rollover Image for the dialog 
box. Choose the image you want to 
appear WITHOUT a cursor over 
it by selecting the Browse button to 
the right of the Original Image box. 

Choose the image you want to 
appear when a cursor IS over the 
image by selecting the Browse 
button to the right of the Rollover 
Image box. Now, type the URL 
where you want the button to take 
people once it’s clicked. 

—Rick Tracewell
Mac Design Magazine

GoLive

GoLive Table Selection Help
In GoLive, if you press Control/

Return while in a table, the next-
outward level of the table will 
be selected. Each time you press 
Control/Return, the next-outward 
level will be selected. To navigate 
back “into” the table, press Return.

— Deborah Shadovitz
Design Tools Monthly

ImageReady

ImageReady Easter Eggs
With Image Ready open, choose 

About ImageReady from either 
the ImageReady, File or Help 
menu depending on what fl avor of 
operating system you’re using. You 

should get the standard ‘about box’. 
Click anywhere within that screen 
to make it disappear and then take 
a look at the top of your tool palette. 

Try holding Option and clicking 
on the big icon that stretches all 
the way across the top of the tool 
palette and what do you see? Th at’s 
right, it’s a rubber ducky! And now 
that you’ve done that, choose About 
ImageReady one more time to get a 
little surprise. 

Now, before you click to make it 
go away, try holding Command and 
clicking anywhere within the blue 
area... what do ya get? More rubber 
duckies!! (Add Shift when clicking 
to clean all the ducks.) 

And just when you thought that 
this ridiculousness had reached 
its high point, create a new empty 
document with a transparent 
background and then type 

“duckerboard” (without the quotes). 
You can type it a second time to get 
things back to normal.

Ben Willmore’s digitalmastery.com

HyperCard

Card Tricked
Q: I’ve resisted moving to OS 

X because I have a HyperCard 
Rolodex with 1,500 entries that 
is absolutely essential to my work. 
I’ve been told that this Rolodex 
cannot be transferred to the OS X 
environment. Is this true? 

—Paul R. Woudenberg
A: Not exactly. Although there 

is no OS X native version of 
HyperCard, you can successfully 
run many HyperCard stacks in OS 
X’s Classic environment. Should 
that prove fruitless, you’re not 
completely out of luck if you’re 
familiar with HyperTalk, 

HyperCard’s programming 
language. Using HyperTalk, you 

can edit the script underlying the 
stack. Solutions Etcetera’s $179 
SuperCard 4 (www.supercard.us) 
uses a language called SuperTalk, 
which the company claims is 80 
percent compatible with HyperTalk. 

Even if the language is only 77 
percent compatible, the structure 
of the two languages is similar 
enough that a modestly competent 
HyperTalk programmer should be 
able to tweak a SuperCard stack in 
the HyperCard stack’s image.

Chris Breen’s Mac 911 
via Connecticut Macintosh 
Connection, Hartford CT

Scanning

Cheap Glass Cleaner
Do not use commercial cleaning 

products on the glass of your 
scanner. Some contain abrasives 
or chemicals that will permanently 
etch the surface. Others can contain 
wax, which causes smears and 
streaks when wiped. 

If professional quality lens 
cleaner is too expensive, make your 
own glass cleaning solution using 
one drop of dish soap, four ounces 
of water, and half an ounce of 
rubbing alcohol. Apply and wipe 
with a soft, clean cloth or paper 
towel; no rinsing is necessary. You 
can save this solution for future use.

Th e Mauger, West Orange NJ

http://www.macromedia.com/exchange/dreamweaver
http://www.supercard.us
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Certifi ed Expert and Training Provider. He also teaches Dreamweaver, Fireworks, and FreeHand, and is a FileMaker Solutions Alliance Trainer. David is also a 
long-time contributor to Mac Design (formerly MacToday) and other publications. 
www.ideastraining.com

• Dave Cross is the Senior Developer of Education and Curriculum for the National Association of Photoshop Professionals. Dave is co-author of Photoshop Trade 
Secrets and Photoshop 7 & Illustrator 10: Create Great Advanced Graphics, as well as a contributor to Photoshop User Magazine.

• Katrin Eismann is the author of Photoshop Restoration & Retouching as well as a contributor to Photoshop Restoration & Retouching as well as a contributor to Photoshop Restoration & Retouching Photoshop User Magazine, and an internationally recognized artist, 
author, and educator. Checkout her website at www.photoshopdiva.com.

• Deborah Shadovitz is the writer of the GoLive column for Mac Design Magazine, as well as featured articles for MacAddict Magazine and MacAddict Magazine and MacAddict Magazine Photoshop User 
Magazine, and is the author of Adobe GoLive Bible, and is the author of Adobe GoLive Bible, and is the author of  (John Wiley & Sons Publishing). Deborah was also a board member of LAMG, the Los Angeles Mac Group.  Adobe GoLive Bible (John Wiley & Sons Publishing). Deborah was also a board member of LAMG, the Los Angeles Mac Group.  Adobe GoLive Bible
www.shadovitz.com.

Books:
• Mac OS X: Th e Missing Manual, written by David Pogue, computer columnist for the New York Times and creator of the Mac OS X: Th e Missing Manual, written by David Pogue, computer columnist for the New York Times and creator of the Mac OS X: Th e Missing Manual Missing Manual series, is the #1 best-Missing Manual series, is the #1 best-Missing Manual
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If you are not a member of a Macintosh User Group, I highly recommend that you fi nd one in your area and join. User groups are the greatest source of 
information and help available to all Mac users — from novices to experts. You can fi nd one in your area by going to apple.com/usergroups/fi nd. 




